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iMovie TutorialiMovie Tutorial
An overview of how to edit digital video 

using iMovie HD ‘06

Section 1: Connecting a Camera and Importing 
Video into iMovie
After filming your digital video, it’s time to import the footage into iMovie. Connecting the digital camera and im-
porting the video onto your hard drive is the first step to editing your movie.

Getting Connected

To import the digital video clips into the computer, you 
must first connect the digital video camera to your 
computer via the FireWire port. The FireWire cable 
will normally be a standard 4-pin–to–6-pin cable. The 
4-pin side goes into the camera while the 6-pin side 
connects to the FireWire port on the computer.

1. Connect the video 
camera to the 
computer with a 
FireWire cable 
(Figure iMovie.1).

Note: TFireWire is an 
Apple created industry 
standard for high-speed 
technology connections. 
It is used for digital video, 
external drives, and video conferencing hardware. On 
the video camera, the 4-pin port is usually under a flap 
and labeled as FireWire, iLink, DV in/out, or IEEE 1394.

2. The camera needs to be set to the Playback 
Mode before importing. The switch near the 

Record button will 
have a few settings. 
Depending on the make 
and model of your 
video camera, one of 
these settings will be 
VCR, VTR, or Play. Set 
the switch to whichever 
of these settings is on 
your camera (Figure 
iMovie 2).

Note: Once the switch is on the Playback Mode, the 
viewfinder will be activated. There may also be a light 
indicating that the camera is on.

Importing (Capturing) Digital Video 
Into iMovie

Before editing your footage, you must first import the 
clips into iMovie.

1. With the camera turned on, set to its Playback 
Mode, and connected to the computer, open the 
iMovie application by clicking on its Dock icon.

Figure iMovie 1
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2. If this is a new project, click on New Project 
during the opening screen. If you are importing 
additional footage into a continuing project, then 
make sure that you choose Open an Existing 
iMovie Project. If you will be doing very little 
editing and only want to add titling, audio, and 
transitions, you can use the Make a Magic 
iMovie button (Figure iMovie 3).

Figure iMovie 3

Note: Creating new projects, opening old projects, or 
making Magic iMovies can also be performed in the 
File Menu. iMovie 6 also allows users to open multiple 
projects.

Tip: Be sure to make note of what you name your video 
project and where you save it. The default save location 
is the Movies Folder, but that can be changed to 
anywhere on the hard drive. You also need to be 
sure to select the correct format for your video in the 
Create Project Window. The most common format 
choice will be DV, but iMovie also has options for DV 
widescreen (16:9), high definition, MPEG-4, and iSight, 
(Figure iMovie 4).

3. Click on the little picture of the camera on the 
Import/Edit Slider (Figure iMovie 5). This 
puts your computer into the Camera Mode. In 
the Camera Mode, the playback controls can be 
used to control your connected video camera. You 
can review your footage and decide on what clips 
you would like to import. This is 
also the screen you need to have 
on when you are exporting your 
video back to camera.

4. To import your footage, click on the Import 
Button. When done capturing your footage, you 
can click on the Stop Button (represented by the 
square) or on the Import Button again. The 
Import Controls also allow you to play,  
fast forward, rewind, pause, and cue up footage 
prior to importing it into your project (Figure 
iMovie 6).

5. Disconnect the camera after all the video has been 
imported. Once you have video clips on the Clips 
Shelf, you’re ready to begin the different steps 
to editing your video. Clicking on the Scissors 
Switch will allow you to edit your movie.

Figure iMovie 4

Figure iMovie 5

Figure iMovie 6

Note: During the import, thumbnail pictures of the 
video clips will appear on the Clips Shelf. If the 
camera has been set-up correctly (date and time is 
set), then a new clip is created for each time the record 
button was pressed on the video camera during filming. 
Each clip will have the total time indicated on the top 
of the frame and the name of the clip on the bottom 
of the frame. You can change the name of the clip by 
clicking once on the name and typing a new one. You 
can also change the name by selecting the clip and 
pressing _-I to Get Info. 

Tip: Turn off the video camera after you have finished 
importing footage.
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Section 2: Using the Timeline
The Timeline has often been called the heart of iMovie. This is where you can visually see the entire movie project 
with the audio tracks.

It’s often beneficial to begin a project by putting all the 
clips you would like to use into the Timeline. There are 
two timeline views that can be activated by a pair of 
buttons above and to the left of the Timeline (Figure 
iMovie 7). The Storyboard View or Clip View is 
represented by a little film clip icon. This view enables 
you to see all your clips in the Timeline as uniformly-
sized squares. The Timeline View can be selected 
by clicking on the little clock. This mode displays all 
the pieces of your video in lengths 
relative to their time. In this view, you 
can see the two extra audio tracks, 
edit audio levels, or synchronize the 
audio to the video.

Note: iMovie is a “drag-and-drop” program. You can 
basically accomplish any task through dragging and 
dropping or by clicking on an apply button.

1. Begin by viewing all the clips you have stored 
on the Clips Shelf. Users can preview a clip by 
selecting it and clicking on the play button.

2. When you find a clip you definitely want to utilize, 
click and drag it to the Timeline to add it to your 
project.

Tip: Because of the uniform size, it is often easier to 
use the Storyboard View while adding clips to your 
project.

3. If there are any clips that 
you definitely want to 
throw out, you can delete 
them. They will go to the 
trash and remain there 
until you empty the trash 
in the iMovie Menu 
Bar (Figure iMovie 8).

Note: The Trash Area will tell you how many 
megabytes or gigabytes of clips you have thrown out. 
There is also an indicator for how much free space is 
still available on the hard drive (Figure iMovie 9).

Figure iMovie 7

Figure iMovie 8

Figure iMovie 9

Tip: If the free space on the hard drive is dwindling, 
and playback begins to stutter, delete some clips you 
don’t need and empty the trash. To empty the trash, 
navigate to the File Menu and select Empty Trash.

4. When you’re dragging clips to the Timeline, make 
sure they are all in the correct order you want.

Tip: Before deleting and emptying the trash, make sure 
you really want to get rid of those clips. If you have 
ample hard drive space, it’s often easier to allow spare 
clips just to stay on the Clips Shelf until the whole 
project is completed. To view the contents of the Trash, 
click on the trash icon or navigate to the File Menu 
and select Show Trash.

Figure iMovie 10

Note: You can view what you have added to your 
Timeline by clicking the Play Button (Figure 
iMovie 10). There is also a Play Fullscreen Button 
that will play your video on the fullscreen. The blue 
triangle and line that move while the video is playing is 
called the Playhead. If you have one clip selected on 
the timeline, you will only view that single clip when you 
press the Play Button. If you click somewhere else on 
the iMovie screen, it will de-select that individual clip 
and allow you to view the whole project. 
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Section 3: Adding Themes, Titles, and Credits 
to Your Movie
Titles and credits are two of the things that separate an iMovie from an unedited video recording. There are a 
number of titling options that range from silly to professional. New to iMovie 6 are cinematic themes that add 
animated, artistic flair to your video.

Titles and Credits

Titling is one area in iMovie that is almost entirely 
customizable. Among the things that can be altered are 
the type of title, length of time the title appears, font, 
font color, font size, and background for the title (over 
black or superimposed on a clip). The Titles Panel 
also has choices for subtitling and credits.

Note: iMovie has several different options for editing 
and enhancing your video project. All of these areas 
are accessed through the Control Palette. The 
options include Clips, Themes, Media, Editing, and 
Chapters. Some of these have additional options. For 
example, the Media Button is the way to access the 
images in the iPhoto library as well as audio (music 
and sound effects).

1. Click on the Editing 
Button in the Control 
Palette (Figure 
iMovie 11). This will 
display more options at 
the top of the Control 
Window that include 
Titles, Transitions, 
Video FX, and Audio 
FX. Selecting the Titles 
Button will give you 
multiple selections of 
the possible titles that 
you can use. Some of 
the titles are grouped 
into families. Clicking 
on a title family will 
expand the list to 
display similar titling 
effects.

Note: To input a title, enter words in the text field. 
Additional text field boxes can be added to certain 
titling choices by clicking on the Plus Button. This is 
especially useful for long titles and for credits.

2. There are several options for altering a title. The 
customizing options are below the titling choices 
(Figure iMovie 12). The Speed Slider is used 
to adjust how quickly or slowly the title will appear. 
Some title styles also allow you to use the Pause 
Slider. The length of pause will vary the amount 
of time the title’s text will stay on screen before 
moving on or disappearing.

Figure iMovie 11

Figure iMovie 12

Note: The total time for the title will appear in the 
thumbnail picture at the top of the panel. It is broken 
into the number of seconds and frames the title is 
active. For example, 12:15 would be 12 seconds and 
15 frames. There are 30 frames per second.

Note: If you put the title over a clip, the clip must be 
long enough for the length of the title. For example, 
if a title is 5 seconds, the clip needs to be at least five 
seconds if the title is superimposed over that clip.

3. The round quad-directional button will allow you 
to alter in which direction your title moves. Not all 
titles allow the motion to change. Some titles, like 
Bounce Across, also allow you to alter other aspects 
of it, like the amount of ‘wave’ in the title.

4. The Color Box allows you to change the color of 
the font. The Over Black Box will put your title 
over a black screen. This is the option to select if 
you don’t want any clips to be covered by a title.
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5. Choose a font from the Family pull-down menu. 
The style of the font can be altered with the 
Typeface menu. The font size can be adjusted with 
the Text Size Slider.

Tip: Larger font sizes are usually easier to read in the 
titles and credits, but subtitles usually have a smaller 
font. If you have a title over a dark background, choose 
a brighter font color and vice versa. The longer a title, 
the smaller the font will be.

7. When you are ready to insert the title, select the 
colored ‘T’ next to the style you have chosen, and 
drag it to the section of your movie where you 
would like to insert it. Alternately, users can select 
the Add button or click the Check mark on the 
preview screen. It will appear as an extra clip and 
begin rendering. When the red line goes across the 
clip and disappears, then rendering is complete.

8. Subtitles and credits can be added in the same way 
as titles. Credits are found in the Titles Panel 
within the Scrolling Family (Figure iMovie 13). 
The main formatting difference between titles and 
credits is that the text in the credit fields works in 
pairs. For example the top box can be used for the 
role and the bottom box for the person who took 
that role. To add more text fields, click on the Plus 
Button in the Titles Panel.

Figure iMovie 13

Tip: In titles, subtitles, and credits, always check the 
spelling before beginning to render.

9. Once rendered, titles can be deleted, moved, 
or edited. To edit an existing title, select it in the 
Timeline and navigate back to the Titles Button. 
You can now make changes to it. Click on the 
Update Button when you are done.

Note: Titles can be added anywhere in a movie.

Important Tip: Save frequently.

Themes

Themes are cinematic animation clips that integrate 
images and text. They are new to iMovie 6 and are 
similar to the full-motion themes found in iDVD. There 
are multiple families of themes that can be accessed by 
selecting the Themes Button on the Control Palette 
(Figure iMovie 14). Themes can be used in lieu of 
titles and credits, or they can be added in addition to 
them.

1. First of all, a theme must 
be selected. Click on the 
Themes Button and 
select a family of themes. 
The various groups can 
be accessed by the drop 
down menu at the top 
of the Themes Panel. 
The groups include 
Travel, Road Trip, 
Pass Through, and 
Reflections. Once a 
family has been selected, 
choose a specific theme 
style (i.e. Open, Credits, 
Bumpers, Lower Thirds).

2. A Drop Zone window will become available 
(Figure iMovie 15). If the grey Drop Zone 
window does not appear, click on the Show Drop 
Zones Button. Drop zones give users easy drag-
and-drop functionality for adding images and 
video into the chosen theme. To add a video to an 
open drop zone space, click on Clips and select a 
video clip to go into a space. To add a photo to an 
open drop zone space, click on the Media button, 
choose Photos, and select an image to drag onto 
the drop zone. Each numbered space in the Drop 
Zone window corresponds to a dark grey area in 
the theme.

Figure iMovie 14

Figure iMovie 15



��

iMovie TutorialiMovie Tutorial

Instructional Technology Outreach, a division of 
Technology Services at Los Angeles County Office of Education

Instructional Technology Outreach, a division of 
Technology Services at Los Angeles County Office of Education

3. Some themes require text for the title or the credits. 
Enter the appropriate information.

4. Preview the customized theme in the Viewer 
Window. If no preview is playing, click on the 
button marked Show Preview. When the theme 
is customized, all images and video added to the 
Drop Zone window will appear in the theme 
(Figure iMovie 16). Click on the Apply button 
or the Check in the Preview to add the theme to 
your movie.

Tip: Add themes and titles between segments to lend a 
touch of class to a movie.

Figure iMovie 16

Section 4: Audio
Another professional touch in iMovie is the ability to 
add audio into your project.

Adding Audio

Audio refers to any sound you might add to your 
movie. These include sound effects, music, and audio 
dubbing (recording narration or other sounds). Apple 
has integrated the iLife applications seamlessly, 
so iPhoto, GarageBand, iTunes, iMovie, and iDVD 
work very well together. This means that your entire 
iTunes Library, including music you have created in 
GarageBand, is available for any movie you create. 
There are three libraries of sound effects that come with 
iMovie 6.

Tip: There are several extra audio and special effects 
created by third-party companies. If you do a general 
search on the Web for ‘iMovie effects’ or ‘iMovie sound 
effects,’ you can find some great add-ons to iMovie.

1. To add to or alter the audio, make sure that you are 
in the Editing Mode (scissors switch).

2. Click on the Media 
Button in the Control 
Palette. This accesses 
the audio and photo 
libraries. Click on the 
Audio Button at the 
top of the Media panel 
(this might be default 
selection). Activating 
the Audio Button will 
allow you to add audio 
from a CD, iTunes, or 
GarageBand (if the 
GarageBand file has 
been saved as an iLife 
Preview). The Audio 
Button also gives you the 
ability to record your  
own voice or sounds or 
add any of the built-in 
sound effects (Figure 
iMovie 17).

3. To add music to your video, select iTunes, Audio 
CD, or GarageBand. Choose the specific song 
desired and drag it to one of the Audio tracks in 
the timeline. You can also add it by clicking on the 
button marked Place at Playhead and it will be 
placed wherever the playhead is.

Note: When you add a sound, iMovie will automatically 
switch the project to Timeline View.

Tip: For fine tuning an audio clip’s start time, you can 
move a sound effect or song by dragging it on the 
timeline or by clicking it and using the left and right 
arrow keys. The selected clip or sound will move one 
frame at a time with the arrow keys.

4. To add sound effects, click on the specific Sound 
Effects library and select the sound effect to add. 
You can sample the sound by double-clicking on 
the sound effect or selecting it and clicking on the 
Play Button. When you find an appropriate sound 
effect you like, drag it to one of the audio tracks or 
select Place at Playhead.

5. To record narration, voiceovers, or self-made  
sound effects, select Audio in the Media panel. 
Click on the red Record Button and begin 
speaking or making noise. Click on the Record 
Button a second time to stop the recording 
(Figure iMovie 18).

Figure iMovie 17
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Tip: For optimum audio quality, put the sound source 
approximately 6-10 inches away from the microphone.

Editing Audio

All audio levels can be adjusted by going to the View 
Menu and clicking on the Show Clip Volume Levels 
(Figure iMovie 19). This will reveal audio reference 
lines along each of the audio tracks (there is one 
included with the video and two audio tracks under the 
video track).

Figure iMovie 18

Figure iMovie 19

1. Click on the line to create an action point. These 
points can be dragged up or down to fade in 
or fade out the audio of a track or sound effect. 
Alternately, if fading in and out is not required, the 
clip volume can also be adjusted as a whole with 
the Clip Volume Slider (Figure iMovie 20).

2. Music and sound effects can also be shortened. 
Make sure that the Show Clip Volume Levels 
is not selected so that iMovie understands you are 
editing the length of the sound. When you the drag 
the cursor to the beginning or end of a sound clip, 
you will see a black arrow 
to indicate you can edit the 
length. Click and drag the 
arrow inward to shorten a 
song or sound clip. Figure iMovie 20

Note: The Clip Volume Slider 
can also be used to adjust the 
audio on a video track. To do 
so, select the video and slide the 
Volume Slider less than 100%. 
Audio tracks can also be muted 
by bringing the Volume Slider 
down to 0% or de-selecting that 
track’s Volume Box (Figure 
iMovie 21).

Figure iMovie 21

Tip: You can shorten songs and utilize a fade in or fade 
out to set the audio to match the video.

Tip 2: The Clip Volume Slider can also be used to 
increase the volume of a video clip if the recorded 
audio is low.

Section 5: Working 
with Photos
Because of the tight integration of the iLife Suite, adding 
still photos to your iMovie is also a simple process. By 
clicking on the Media Button in the Control Palette 
and selecting Photos, you can include any photo from 
your iPhoto Library. The Photo Panel also gives you 
several options for displaying your photos in iMovie.

1. To add photos, click on 
the Media Button in the 
Control Palette. Clicking 
on the Photos Button 
opens the Photo Panel 
(Figure iMovie 22).

2. You can select a specific 
album inside of your 
iPhoto Library by clicking 
on its name.

3. Select the photos you 
want to include from your 
iPhoto Library.

Figure iMovie 22
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4. To modify photos before importing them, use 
the Photo Settings palette. If it does not open 
automatically when an image has been selected, 
click on the Show Photo Settings button  
(Figure iMovie 23).

Figure iMovie 23

5. The Hare and Tortoise Slider will adjust the total 
amount of time the photo will appear. The Zoom 
Slider will adjust how much each photo will be 
enlarged.

6. When you have modified the photo you want to 
import, click on the Apply Button. 

Note: To import photos not in your iPhoto Library, go to 
the File Menu and select Import. Locate the image 
you want to add and click on the Import Button.

7. The photos will be inserted in your Timeline, but 
you can drag them to the Clips Shelf or anywhere 
else in the movie.

Creating Still Frames vs. Saving Frames

When working with iMovie, you can create a low-
resolution image from your video footage. Any frame 
of footage can be converted to an image. There are 
two ways to do this. One way is to use the Create Still 
Frame option.

1. Move your playhead to the frame that contains the 
image that you want to use. This can be from a 
photo or video clip.

2. From the Edit Menu, select Create Still Frame. 
This creates a still frame that will appear on your 
Clips Shelf.

Note: You can edit the name of the still frame and 
adjust the length of time that it will play, but you cannot 
use the Ken Burns Effect to add panning or zooming 
functionality to it. To edit a clip’s title or duration, 
double click the clip to access its information and 
change it.

Saving a Frame is similar to creating a still frame, 
but it allows you to save the image as a JPEG file. 
This provides more flexibility, but requires an extra 
step to import it into your project. The greatest benefit 
to saving a frame is that, as a JPEG, you are able to 
manipulate it with the Ken Burns Effect.

1. Move your Playhead to the frame that contains the 
image that you want to use. This can be a frame 
from a photo or video clip.

2. From the File Menu, select Save Frame. Enter a 
name and select a location to save your frame. You 
will also be given an option for the format of file 
(JPEG or PICT).

Tip 1: Be sure to note where you saved your image, 
or you will have difficulty importing it back into your 
project.

Tip 2: Stick to JPEG files because they are universal to 
any computer platform. PICT files are an image format 
often found on Apple Computers but not widely used 
on Windows machines.

3. Go to the File Menu and select Import. Navigate 
to where you saved your frame and select it. Click 
on the Import Button.

4. Your file will appear on the Clips Shelf. After 
dragging it to the timeline, you can use the Ken 
Burns Effect on it or change its name.

Note: A still frame created from a video clip will often 
look blocky. This is a result of the relatively lower-
quality image sensors on a video camera vs. a digital 
still camera. Some cameras that have 3 CCDs (or 3 
chips) or are high definition, will have a higher quality 
than a single CCD digital video camera when creating 
a still image from a frame.

Using the Ken Burns Effect

The Ken Burns Effect allows you to pan across and 
zoom in or out of your photo. These effects can be 
customized and even turned off.
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Note: Ken Burns is the award-winning filmmaker whose 
documentaries are famous for panning across and 
zooming in and out of photos. The dramatic effects 
highlight different parts of the photo or reveal fine 
details to the viewers.

Tip: Do not select the Ken Burns Effect box if you are 
importing multiple photos. Each photo will import more 
quickly and without effects. You can modify or add 
effects to each image individually.

1. Select the box labeled Ken Burns Effect found in 
the Photo Settings palette (Figure iMovie 24).

2. To zoom in on a photo, select a photo, press the 
Start Switch, and use the Zoom Slider to move 
to 1.00 or any other low number. Press on the End 
Switch and move the Zoom Slider to a greater 
number. Click on the Apply Button.

3. To zoom out of a photo, select a photo, press the 
Start Switch, and use the Zoom Slider to move 
to a number greater than 1.00. Press on the End 
Switch and move the Zoom Slider to a lesser 
number. Click on the Apply Button.

4. To pan across a photo, set the Start and Finish 
Zoom to the same value. Move your cursor over 
the preview picture in the Viewer Window. By 
clicking and dragging, you can move a photo. 
Change the center of the image to a different 
section in the start and end. Click on the Apply 
Button.

Note: The longer the duration of the photo, the slower 
the pan and zoom effects will be.

Note 2: Images can have a simultaneous pan and 
zoom.

Figure iMovie 23

Tip: By importing the same photo multiple times, you 
can incorporate a variety of effects on an image, like 
zooming in, holding for a few seconds, panning across, 
and zooming out again.

Section 6: Video FX 
and Audio FX
Effects can be added to any video, still image, or audio 
segment. Used appropriately, they can alter the mood 
of a video, create amusing effects, or add a touch of 
professionalism to a movie project. 

Video FX

Video FX are any visual 
effects applied to a video 
clip or still image. Some 
Video FX include adding 
rain, altering colors, and 
changing the speed of a 
clip. Through the Video FX 
Panel, you can even age a 
film, cause an earthquake, 
or enlarge a character’s 
nose.

1. To begin adding special 
effects, click on the 
Editing Button in the 
Control Palette. Next, 
click on the Video FX 
Button at the top. This 
will open up the Video 
FX Panel (Figure 
iMovie 25).

2. To add an effect to a clip, you must first select the 
image or video clip you want to change, then click 
on the special effect you want to use to modify it. 
A preview will appear in the Viewer Window 
(Figure iMovie 
26). When you’ve 
decided on an 
effect, just click on 
the Apply Button, 
and it will render 
the effect.

Figure iMovie 25

Figure iMovie 26
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3. It is also possible to add effects to the titles and 
credits. Some effects can be layered. For example, 
a clip with rain can also be black and white.

Note: Effects, titles, and transitions will render faster 
when they are applied individually, but the total time 
involved in rendering things one at a time is about 
equal to the amount of time it takes to render multiple 
items all at once. 

Tip: Do not try playing your video while rendering is 
going on.

Audio FX

Audio FX are any digital changes to the audio of 
video clips, music, or sound effects. Through the use of 
Audio FX, voices can be altered and echo and reverb 
can be applied. There are also a host of other filters to 
improve or transform audio in iMovie.

1. To begin adding special effects, click on the Editing 
Button on the Control Palette. Next, click on the 
Audio FX Button at the top. This will open up the 
Audio FX Panel (Figure iMovie 27).  There are 
several choices of audio effects. 

Figure iMovie 27

2. To add an effect to a clip, you must first select the 
video or audio clip you want to change then click 
on the special effect you want to use to. By clicking 
on the Preview Button, the altered audio will play 
in a loop. When you’ve decided on an effect, just 
click on the Apply Button, and it will render the 
effect.

3. Audio effects can be layered. For example, a clip 
with an echo can also have the noise reduced.

Tip: Audio FX, especially the Pitch Change, are 
fun for students, but emphasize the need for clear 
communication to students before they change their 
voice to sound like a chipmunk.

Section 7: Editing Clips
Editing clips includes splitting single sections of video 
into two or more separate clips or cutting out any 
unwanted sections at the beginning, middle, or end of 
a clip. This step can be completed during the dragging 
of good clips to the Timeline, however, some people 
prefer to do the fine editing right before adding 
Transitions.

Note: A useful feature in iMovie, added since iLife Suite 
‘04, is the ability to perform “non-destructive” editing of 
clips. Filmmakers can now edit the beginning or ending 
of a clip (the Mark In and Mark Out points) without 
cutting them out permanently. This style of editing 
allows for more flexibility when fine-tuning a project.

1. To split a clip into more than one segment, it needs 
to be selected. Advance the Playhead to the exact 
moment you want to split the clip. From the Edit 
Menu, select Split Video Clip at Playhead 
(Figure iMovie 28). You can also use the 
keyboard combination of _–T to split the video clip. 
This will cut the clip into two pieces.

Note: Users can also split audio by selecting an audio 
clip instead of a video clip. In the Edit Menu, the choice 
Split Audio Clip at Playhead will appear.

Tip: For more precision in selecting where you split the 
video, use the arrow keys to advance the Playhead 
one frame at a time.
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2. To Cut or Crop a video clip, use the small triangles 
located at the bottom of the viewing screen. The 
first triangle on the left is the Mark In and the 
second triangle on the right serves as the Mark 
Out point (Figure iMovie 29). The Cut and Crop 
functions are also located in the Edit Menu.

Figure iMovie 29

3. Cutting the video means that you will cut out 
anything inside the Mark In and Mark Out 
points. It deletes the section that is selected between 
the points (the yellow portion).

4. Cropping the video means that you will delete 
sections of the video that are outside the Mark In 
and Mark Out points (the blue portion).

Tip: When cropping clips, make sure you leave some 
Handles. These are the spaces at the beginning 
and ending of each clip. If you are planning to have 
Transitions between clips, it’s a good idea to have 
handles of approximately one or two seconds at the 
beginning and end of each clip. This amount can 
always be cut or cropped out later.

5. To edit without permanently changing the original 
clip, make sure that Show Volume Levels is not 
selected. Just like editing the length of a sound 
clip or song, position the cursor at the edge of the 
video clip. A black arrow will point at the clip that 
will be shortened. Click and drag the beginning or 
ending of the clip to change the Mark In or Mark 
Out points.

Tip: Non-destructive editing is especially helpful if a 
project needs to be edited to a specific amount of 
time (i.e. a 30- second commercial or public service 
announcement). It is also great for fine-tuning the final 
edit of a scene.

Note: You can only stretch a clip to its original length. 
iMovie will not add more time to a clip if there aren’t 
adequate handles at the beginning or end of the clip.

Section 8: Adding 
Transitions
Transitions are the effects that visually link two clips 
together. Transitions are usually added after all titles, 
credits, editing, and effects have been completed. 
Adding any of these things afterward will automatically 
make the transition ineffective (imagine stitching a quilt 
together and deciding to change a single panel after 
stitching it). Many filmmakers like to add a soundtrack 
after the movie is completed. Others like to have a 
soundtrack in mind in order to edit the movie and add 
transitions artistically. There are several transitions 
available that are customizable.

Note: Transitions will take a portion of each clip that 
it links, so having adequate handles is essential for 
longer transitions.

Tip: There are several third-party transition makers. 
By doing a general search on the Web for ‘iMovie 
transitions,’ you can find many cool transitions not 
included in iMovie.

1. To add transitions, click on the Editing Button in 
the Control Palette. Next, select the Transitions 
Button at the top of the window. This opens the 
Transitions Panel (Figure iMovie 30).

Figure iMovie 30
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2. Position the Playhead between the two clips you 
want to add a transition. Select a transition.

3. Click on the Preview Button to see what the 
transition will look like.

4. The transition can be customized in two ways. 
Alter the Speed Slider to modify how long the 
transition will take. If the transition moves the 
image, then the circular Direction arrows will 
change which way the transition will go.

5. When you have chosen a transition and customized 
it, drag it between the clips you are putting together 
or click on the Add Button to begin rendering it.

6. Add transitions between as many clips as desired.

Note: Many movies use a Fade In or Wash In before 
the first clip begins and use a Fade Out or Wash Out 
after the final clip in a scene.

7. After all transitions are rendered, you are essentially 
finished with your project.

Tip: View your movie before calling it a ‘wrap.’ Sound 
may need to be adjusted slightly.

Tip 2: Use Transitions sparingly. They can change the 
overall length of a film and detract from what the 
project is communicating.

Section 9: Publishing 
Your Work
Once you’re finished with your 
movie, it’s time to publish or 
distribute your work. Sending 
your work out in a variety of 
formats is known as Sharing 
or Exporting. There are several 
options for exporting your movie. 
All of these options can be found 
in the File Menu under Export 
or in the Share Menu (Figure 
iMovie 31). The next three sub-
sections are about the options 
for Sharing to Videocamera, 
QuickTime, or iDVD. Figure iMovie 31

Note: The Export Window has eight icons at the top 
to compress your movie for sharing via Videocamera, 
QuickTime, Email, Bluetooth, iDVD, iPod, iWeb, 
and GarageBand. For example, the iWeb Option 
compresses the video for easy use within a webpage 
created with iWeb. The GarageBand option 
sends the movie to GarageBand for adding more 
professional music, sound effects, or narration. The 
iPod option compresses it for playback on an iPod or 
as a video podcast.

Note: Whether you use the Export Window in the 
File Menu or the options from the Share Menu, the 
results will be the same.

Tip: The hot-key combination to Share is shift-_-E.

Exporting to Camera

This option sends your movie back to the DV tape. 
From the DV tape, you can transfer to a VHS tape or 
connect to an LCD projector. Sending back to a tape 
provides a high-quality, uncompressed copy of your 
movie.

1. Connect your video camera to the computer with a 
FireWire cable, turn it on, and select the Camera 
Switch in the iMovie interface for importing and 
exporting video.

2. Go to the Share Menu and select Video 
Camera. This will open the Export Window 
and pre-select the video camera option (Figure 
iMovie 32).

Figure iMovie 32
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3. Enter how many seconds of black you want at the 
beginning and ending of your movie.

4. Click on the Share Button and wait for the movie 
to finish exporting.

Exporting to QuickTime

This choice gives you the most options for customizing 
your exported movie. There are several preset options 
that compress your movie appropriately for different 
mediums. These choices include Email, Web, Web 
Streaming, CD-ROM, and Full Quality DV. Apple 
has named these options for the medium that you 
intend to use to deliver your movie. For example, if you 
are sending the movie through Email, then choose the 
Email Option. The CD-ROM Option is appropriate 
for movies that will be played in a CD drive. Exporting 
to QuickTime has many of the same options as the 
preset buttons for sharing, but it will save a copy to 
your hard drive. This enables a user to archive movies 
more easily.

Note: Depending on the system and memory of your 
computer, movies played from a CD-ROM may not 
play smoothly on the screen. This is especially true on a 
laptop. It’s best to copy the movie onto the hard drive 
prior to playing it.

Tip: Export movies as Full Quality DV if you want to 
archive them, create video compilations in iDVD, or to 
use with DVD Studio Pro. You will not need a camera 
connected to your computer for the QuickTime sharing 
options. However, you will need enough hard drive 
space to save the QuickTime file.

Note: There is also an Expert Settings selection that 
allows you to save your movie in a number of other 
formats including AVI, MPEG-4, and Toast VCD. This 
option allows you to save parts of your movie, like one 
image or the soundtrack, as a separate file. Video CDs 
created with Toast Titanium are lower-quality than a 
DVD, but they will fit on a single CD and playback in a 
VCD Player.

1. Go to the Share Menu and 
select QuickTime. This will 
open the Export Window.

2. Choose the format for your 
movie via the drop-down 
menu (Figure iMovie 33).

Figure iMovie 33

3. After deciding on your options, click on the Share 
Button and wait for the movie to finish exporting.

Exporting to iDVD

If your movie is the 
centerpiece of an iDVD 
project, then selecting 
iDVD in the Share Menu 
or Export Window will 
automatically send your 
project to iDVD. If you want 
your DVD to play Chapter 
Selections, then be sure 
to click on the Chapters 
Button in the Control 
Palette so that you can set 
Chapter Markers. This will 
allow you to jump to specific 
sections of your movie 
quickly and create Chapter 
Selections on the DVD 
(Figure iMovie 34).

Tip: All iMovie projects can be accessed from iDVD 
when they are in the Movies Folder (the default).

Note: Chapter Markers can also be used in a video 
podcast.

1. Select the Chapters Button in the Control 
Palette to create Chapter Markers.

2. Advance the Playhead to the important sections 
of your movie. For each section, click on the Add 
Chapter Button and name your chapter.

3. When all the Chapter Markers have been placed, 
you can export your movie for iDVD by selecting 
iDVD in the Share Menu.

6. Click on Share to send your project to iDVD.

Note: If you do not have a SuperDrive, you can 
still create an iDVD project and later transfer it to a 
SuperDrive enabled PowerMac.

Figure iMovie 34
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Section 9: Making Magic iMovies
In iMovie HD, there is a simplified workflow solution called ‘Make a Magic iMovie.’ This selection in the opening 
window will lead the user through the process of creating a video quickly and easily with titles, transitions, and a 
soundtrack. It can even create an iDVD Project when it’s done.

Tip: Magic iMovies are most appropriate for 
videos that require a minimum of editing. Concerts, 
recorded plays, and other commemorative events are 
appropriate choices as Magic iMovies because they 
don’t require extra titling like subtitles.

1. To begin a Magic iMovie, select it in the opening 
screen. Alternatively, you can navigate to the File 
Menu and select Make a Magic iMovie from the 
choices. This activates the Magic iMovie Options 
Window (Figure iMovie 35).

2. Enter a title for your Magic iMovie and select the 
format (DV unless you are doing a widescreen or 
High Definition video).

3. The Magic iMovie Options Window will allow 
you to set a standard transition between all clips or 
none at all. This is also the screen that gives you 
options for your music and whether or not you want 
it to be sent to iDVD automatically.

Note: If the Send to iDVD box is selected, you will 
not have a chance to do any fine-tuning and further 
editing. Without the box checked, the user can fine-tune 
the editing, titles, and audio.

Figure iMovie 35

4. If you elect to add music to your Magic iMovie, 
you will be prompted to click on the Choose 
Music Button. This will open an additional 
window where you can select one or more tracks 
from your iTunes Library to add to your movie. 
You can also adjust the volume of the video and 
music with the Audio Mixing Slider. When your 
audio selections have been made, click the OK 
Button.

5. After music has been selected, you can check the 
Magic iMovie Window to get an overview of 
your selections and then click on Create to begin 
the process.

6. The Magic iMovie Progress Window will open 
and automatically import video clips, add titles, 
create transitions, add music, and send to iDVD (if 
selected).

7. If the Send to iDVD box isn’t checked, then the 
movie will finish and you will have an opportunity 
to edit, add effects, or use any of the features 


